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T1 eival n Matlab

® OAokAnpwuéEvo MNepiBaAAov

® [TepiIBaAAov avamTucng

® Algppynveupevn YAwoaoa

® YynAn €mridoon

® EupuTtnTa epapuoywyv

® EukoAia diatuttwong

® Cross platform (Wintel, Unix, Mac)




Tumkec xpnoeic Tnc Matlab

® ATTOOO0TIKI) UAOTTOINON OAYOPIOUWY

® ETmriAuon AE

® [lpoocopoiwaon AIVOUEVWY

® ApIBunTikA avaAuon, YPAUUIKN aAyeRpa
® BeATioToTtroinon

® Avartrtu¢n Aoyiouikou (GUI)

® ETrecepyacia onUATWY




loTOpPIx

® 1970: O Cleeve Moler ypdagel THV TTPWTN
£¢kdoon ot Fortran.

® ApXIKQ, EKTTAIOEUTIKA XPNON
® ‘Evive gutropikn 10 1984, Mathworks.
® > nNuepa, ypappévn oe C kail Java.




2To1xeia Tn¢ Matlab

® Matlab: Matrix Laboratory

® Baaoikry doun tn¢ Matlab €ivail o Trivakacg
Ev vével yiyadika oToixeia
® Oikoyévela toolboxes (OUAANOYEC
ECEIOIKEUMEVWYV OUVAPTACEWYV). TT.X.
Statistics Toolbox
Image Processing Toolbox
Bioinformatics Toolbox ...K.4.




Matlab Interface

® To Interface Tng Matlab xwpileTtal o€ Tpia
Tapadupa:

To Workspace (TTavw aploTepr] ywvia) TTapabeETel
OAEC TIC HETABANTEC TTOU £XOUV OpIOTEl Kal Ta m-files
(apxeia KWOIKA).
To Command History (KAtw aploTEPN ywvia)
TTAPOAOETEI TIC EVTOAEC TNG TPEXOUOOC OUVEDPIAC HE
TNV OEIPA TTOU £XOUV EKTEAEOTEI
Command Window (0e€1a TTAeupQ) Bacikn €ic0d0¢g
Kal ££000C EVTOAWV, OPICUOU PETARANTWY KAl
UNVUPATWY AdBouc.




L MATLAE =10/ x|

File Edit Yiew Web ‘Window Help

0 Iﬁ-’-| ¥ P o o | % | 2 |Currerrt Directory: | c:prograr1MATLABESwork | J
. i n B | Command Windows n |
@ E | m | ﬁ Stad(:IElase vI Tzing Toolbox Path Cache. Type "help toolbox_path cache™ for more infc=)
Name |Size | Bjﬂ:ESlClass | To get started, select "MATLAE Help™ from the Help memnun.

=

JE1 I3 Workspace | Current Directory

Cormrnand Hi:

(-- 1/09704 735 PM --%

<\ Start |




Current directory

® 21N ypauun Jyevou ..., UNTTOPOUNE VO OPIOOUME
1O directory oto oT1T0i0 B0 YpAaPel Kal Ba
dlafadlel Ta m-files. NpoTteiveTal va
ONUIoUPYNOETE €va veo directory (T1.X. matlab)
OTOV Aoyapliaouo oag, OTOV OTToio va
atroOnkeveTe Ta M-files cag Kal OAQ Ta OXETIKA
apxeia.

® Orav avoiyete TNV Matlab, aAAacte To Current
Directory o€ auto 10 directory €101 WOTE va EXEI
TTPOOBaon oTa ApXEia oac.




} MATLAB
File Edit Wiew Web MWindow Help

O E?r| k3 B o o | . | ? |Currerrt Direstory: | c:iprograr1MATLABESWwork

Cormrmand Yindows

Uszing Toolbox Path Cache.

ﬁ. E | m | ﬁ Stadc:IElase VI

Name |Size | Byteslmass | To get started, select "MATLAE Help”™ from the Help menu.

2

Browse For Folder | ]

Select a new directory

EH:I ahaubold
-] application Data

-~
1 an J

D Cookies
{:I Desktop
0 13 Current Directo " Rantad
_ Workspace | i {:I htdocs
Command History D jEI\"EI
= {:I ledlamp

H-— 1/09/04 7:39 FM --% §1-C3 Local Settings

- T
G mp3
B-1 My Dacuments

{:I MetHood _I

I e T TR T

Foldet: I matlab

(a4 I Cancel Mew Folder |

4

Type "help toolbox_path cache™ for more info =

<\ Start |




MEPIKEC ATTAEC EKPPATEIC

® 'Ypwon o duvaun x*y .
® Terpaywvikn pila sqrt(x) .
® To Workspace kal To Command History

EVNMEPWVOVTAI KOBWC EKTEAOUVTAI Ol
UTTOAOYIOUOI TWV EKPPATEWV.

® OT1roladNTTOTE YETABANTA TTOU EpPavideTal
o1o Workspace utropei va XpnoidoTroinoei.

® ans cival n default yeTaBAnNT TTOU TTEPIEXEL
TO TEAEUTAIO ATTOTEAEC Q.




<) MATLAB

File Edit WYiew Web Window Help

0 E’:| 4 B« s | & | ? |Currer|t Directnry:|c:1nocumems and Settings\ahauboldimatish

=1

=10l %]

lILI Workspace

2[x]|
E | H | ﬁ Stadc:IElase VI
Size Evytes|Clas=
1x1 G| double array

Current Directory

Cormrnand His

1+1
sqrti9)
a2

3*24+10

A% (54197 /3

(-- 1709704 7:35 PM --%

Cormrmand Windoes

To get started, select "MATLAE Help™ from the Help menu.
== 141

ans =

x> BUrLi9)

FroBME

36
FrO3TEH10
ans =

la

A% (3+19) /3

:

3z

Tzing Toolbox Path Cache. Type "help toolbox path cache™ for more info =)

]|

+\ Start |




MeTaBANTEC

® Q1 yetaBAnTEC opiovral ye avabeon o€ KATTOIO
YPAuua 1 AéEn evoc aplBuou | JIag EK@Pacnc.

® OAeg o1 HETABANTEC TTOU £XOUV OPICTEI OTO
Workspace ptropouv va xpnoiJuoTTolouvTal
KATA TNV OIAPKEIA TNG aUVEDpPIAC.

® H xpnion YETABANTWY TTOU OEV £XOUV OPIOTEI
EMOTPEPEI uAVUNA AdBouc.




File Edit WYiew Web Window Help

<} MATLAB .

=10l %]

0 E’:| 4 B« s | & | ? |Currer|t Directnry:|c:1nocumems and Settings\ahauboldimatish

=1

ﬁ.’- E | H | ﬁ Stadc:IElase VI
Size Evytes|Clas=
1x1 G|double array
1x1 G|double array
1x1 G| double array

lILI Workspace

Current Directory

Cormrand History

(-- 1409704 7:39 PM --%
1+1

sqrti9)

a2

3%2+10

A% (54197 /3

a=5.z2

b=14.5

ath

ans*z

Cormrmand Windoes

»» a=5h.2

5.2000

*» h=14.8

14,3000

»» ath

20

= oans¥a

40

»» oansva

+\ Start |




MeTaBANTEC

® H Matlab xeipietail TIC yeTABANTEC by
value Kai oI by reference.

® ‘EoTtw OT11 £X0UV OpIOTEl OI HETARBANTEC a
Kal b kai opidetal N w¢ c=a+b, av otn
ouvexela aAAAagel n Tiun Tou a, TO €
TTAPAUEVEI va 1o0UTaAl e TO ABpoioua
TWV apXIKWV a Kai b.




<} MATLAB .

File Edit WYiew Web Window Help

= | o B o o | 4 | ? |Currerrt Directory: | c:iDocuments and Setingstahauboldimatisa ¥ | J

=10l %]

i = = nm Command Windows
= H | H | iy | Stadc:IElase vI
Size Evytes|Clas=
1x1 G|double array
1x1 G|double array
FF oA
1x1 G| double array
1x1 G|double array a =
L.2o0o
> b
b =
14,5000
Al Warkspace | Current Directary |
C
Cormrand History
542 a1z =
3*2+10
4% [5419) /3 20
a=5.2
>= a=100
b=14.8
a+h -
ans 2
a+tc 100
c=a+h
o
at+bh=c
a -
b
C 20
a=100
= |
C
= 4|




Alaypapn JETARBANTWYV

® Ta mrepiexoueva tou Workspace
dlaypagovTal he TNV EVTOAN clear, n
oTroia dlaypa@el OAEC TIC HETAPBANTEC TTOU
£XOUV OpPIOTEI.

® Ta TrepIieXOUEVO OAWV TWV TTAPABUPWYV

LUTTOPOUV va dlaypa@ouV aTTo TO JEVOU
Edit.




=10l

File | Edit View Web Window Help

0O [ Zhrl+E ? | Current Directory: IC:'lDucuments and Settingztahauboldmatisb j J
— | FHedo
= - |
izt (Zhrl
= Ty, (Zh|HE ]
= Paste (Zhrl
- E Paste Special... BYtESl L1zE8 |
Select all
Delete Delete
Find. ..

Clear Command Yindow

Clear Command Hiskory

Clear Workspace

IK1 13| Workspace | current Directary |

Cormrmand Hi: 3 |

3*2410 AI
4% [ 54+19] /3
a=5.2
h=14.5
ath

ans*z
atc
c=ath
ath=c
a

a]

c
a=100

clear

ﬁ-startl



Alavuopuara

® [x:z] opilel Eva diIAvuopa ApIBUWY TTOU CEKIVA JE X KAl
TEAEIWVEI NE Z, augdvovTag kKaTa 1. 1.x. [3:9] opilel TO
dlavuoua [3,4,5,6,7,8,9].
[x:y:z] opiGel Eva Olavuoua apIBUWY TTOU &EKIVA UE X Kal

TEAEIWVEI NE Z, augdvovTag KaTa y. 11.X. [10:2:20] opilel 1O
diavuoua [10, 12 14,16,18,20].

KaBe opiopdg YeTaBANTAG ETTIOTEPEI TNV TTOCOTNTA TTOU £XEl
OPIOTEl KOl KABE EKPpaoT ETTIOTPEPEI £VA ATTOTEAECUA.

MT1TOpoUpE va TTEPIOPIOOUNE TNV £€000 OTNV 000VN
E('])COVTGQ OTO TEAOG TNG EKPPACNS TO EAANVIKO EPWTNUATIKO
;).
1.X. a=[1:1000000] cmoTpEPel £va diavuopa ue 1,000,000 oToixeia,
TTOU ioWw¢ va unv BEAoupe va doupe otnv oBovn!!!
Av ypaywoupue a=[1:1000000]; 6a opicoupe TNV HETABANT XWPIS va
TNV EPPAviIoOOUHE TNV 000V




=0l x]

File Edit Wiew Web Window Help

[ Ei'i‘-| % B v cu | ] | ? |Currerrt DirEﬂDrYilc:ﬁDncumems and Seftingziahauboldimatish j J

n | Command Window

E | H | ﬁ Stadc:IElase VI

Gize Bytes|Cla=ss 3 =
1x1 G| double array
&
lx19 152 | double array
=» t=[1l:10]
t =
1 2 3 4 5 & 7 g 9 10
=r» t=[l:0.5:10]
T =
_‘ILI Yarkspace Current Directory Columns 1 through 7
Cormmand Hi:
1.000a0 1.5000 Z.0000 2. 5000 3.0000 3. 5000 4. 0000
(-- 1709/04 7T:46 PM --%
2=6 Columns & through 14
t=[1l:10]
4, 5000 L.0000 5. 5000 &.0000 £. 5000 7.0000 7.5000
t=[1:0.5:10]

t=[1l:0.5:107; Columns 15 through 19

g.0000 g. 5000 9.0000 9. 5000 10.0000

=» t=[l:0.5:107];
Fr

Al <tart |



[Tpaceic apiBuou ue diavuoua

® ‘ExovTtac opioel HETAPBANTEC yIa Eva dlAvVUC A
KAl Evav apIOuo uTTopoupE va
TTPAYMOATOTTOINCOUUE APIOUNTIKEC TTPALEIC.

® H rpdoBeon (TToAAATTAACIAOUOG, KTA.) EVOC
dlavuopaTog t ue Eva apIBUo s TTPOCOETE!
(TroAAaTtTAao1aCel, KTA.) KABE OTOIXEIO TOU
OlaAVUCUATOG UE TOV apIOUO.

® To atrotéAeoua Tou s * t PuTTOPEi Va eKXWwPNOEI
oTn METABANTA U OTTWGC U =8 * .

® H petaBANTA U ava@PEPETAI OTO UTTOAOYIONEVO
dlavuoua.




<) MATLAB i

File  Edit

[ EF:'| & B« oo | K | ? |Currer|t DirECTDWiIC:WDucuments and Settingzahauboldmatlabh

Wiew wieb  Window Help

|l

t¥s3

[ x]|
Size Evtes|Class
1x19 152 | double array
1x1 G| double array
1x19 152 | double arrawy

Current Directary

(-- 1709704 7T:d6 PM --%
3=6

t=[1l:10]
t=[1l:0.5:10]
t=[1:0.5:107]:
t+=

Comrmand YWindows

e v ]

ans =

Columns 1 through 7

7.0000

Columns & through 14

10. 5000

7.5000

11.0000

1

Columniz 15 through 19

14.0000

= L¥s3

Columns 1 through 11

14. 5000

1z

1

15

Columns 12 through 19

39 4

> |

(

45

45

g.oooo

1.5000

L.o0oo

13

5l

g.5000

1z.0000

15.5000

21

54

24

a7

9.0000 9.5000
12,5000 13.0000
l&.0000

27 30 33
&0

10.0000

13.5000

3a

<\ Start |




[Mpdacelc OIaVUOUATWY OTOIXEIO TTPOC OTOIXEIO

® Auo diavuopara pe Tnv idla diacTtaon a kai b
TTPOOOETOVTAI /APAIPOUVTAl OTOIXEIO TTPOC OTOIXEIO PE
XPNoN TWV TEAEOTWV + Kal -, TO idIO YiVETAI KAI JE TNV
TPOCo0Oeon Kal agaipeon mMvAaKwy. (Ta diavuouaTta Ogv
gival TTapad TTiVOKEG JE Mia HOVo Ypauun).

['la va TToAAatTAacidooupe (dlaipéooupe) diavuouara
OTOIXEIO TTPOC OTOIXEIO Ba TTPETTEI VA
XPNOIUMOTTOINCOUME TOV TEAEOTN .* (N ./).

[0 va KAVOUUE TTPACEIC OTOIXEIO TTPOC OTOIXEIO dUO
OlIaVUOUATWY TTPOUTTOBETEI OTI £XOUV TO 010 JAKOC,
dlapopeTika N Matlab emoTpEpel error.




<) MATLAB

File Edit Wiew Web MWindow Help

[ EF:'| & B < o | K | ? |Currer|t DirECTDWiIC:WDucuments and Settingzahauboldmatlabh

=

[ x]|
S @@ 5 e

Size Evtes|Class

1x11 88| double array
1x11 858 | double array
1x11 88| double arrawv
1x1 G| double array
1x19 152 | double array

Current Directary

(-- 1/0%9/04 7:46 PM --%
3=6

t=[1l:10]
t=[1l:0.5:10]
t=[1l:0.5:10];:
t+=

t¥3

a=[0:10]
b=[10:20]
ath

a*h

a.*h

Comrmand YWindows

»» a=[0:10]

»» b=[10:20]

b =
10 11 12 13 14 15
> ath
ans =
10 12 14 1la 18 Z0
»» a*h

#72 Error using ==> ¥

Inner matrix dimensions must agree.

>> a.*h

ans =

s

la

&2

1]

17

24

1145

13

Z6

144

19

2

171

10

20

30

Zo0

<\ Start |
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File Edit WYiew Web Window Help

O E’:| % B o | & | ? |Currer|t Directory: | c:iDocuments and Setingstahauboldimatisa ¥ | J

W =5 = l:!!1 Comrmand Windoe
= = W - G Tt |

Size Evytes|Clas=

1x11 858 | double array

1x11 88| double arrawv

1x13 104|double array

1x1 G|double array

1x19 152 | double array

> h=[10:2Z]

JE1 I3 \orkspace | Current Directory

Columnz 1 through 11

Cormrand History
(-- 1409704 7:d5 PM --% 10 11 1z 13 14 15 la 17 13 19 20
3=0
t=[1:10] Columnhz 12 through 13
t=[1:0.5:10]
21 22

t=[l:0.5:107:
E+s3 > ath
t¥3 77 Error using ==> +
a=[0:10] Matrix dimensions must agree.
b=[10:20]

Froa
a+h
a*h a =
a.*h
bh=[10:22] I 1 2 3 4 5 & 7 g 9 10
ath

= =
a -

+\ Start |




Alavuopuara

® Ta dlavuopaTa PUTTopouyV va oplIoTOUV UE
ATTaPIOUNON TWV OTOIXEIWV TOUG £va TTPOC £va
TT.X b=[1,6,-9,2,5.8,sqrt(6),4"3,factorial(5),8*3.4-4*0.1,1/74] ).

® H avaoTpopn yivetal alovrag 1o cuuBoAo (')
TTPIV ATTO TO OVOMa TNG METAPBANTAG, TT.X. b'.

® Me auTO TOV TPOTTO MTTOPEI VA ViVEl
TTOAAATTAQCIACUOC DIAVUCTUATWY YPAPOVTAC
TNV ékppaocna * b' .




File Edit View Web Window Help

<) MATLAB

& m’:| % B o s | & | ? |Current Dirednry:|c;mucumems and Settings\ahauboldmatish

=

=101 %]

-- 2] x]|
= W | B B e[ o

Size Bytes|Clazss

1x11 58| double array

11x1 G8 | double arravy

1x11 G5 | double array

1x1 G| double array

1x19 152 | double array

Current Directary |

t=[1:10] AI
t=[1:0.5:10]

t=[1:0.5:107:

t+s

t*s3

a=[0:10]

h=[10:20]

ath

a*h

a.*h

b=[10:22]

ath

a

b=[1,6,-9,2,5.8,3qrC(6) , 43, factorial (5] ,6%3.4,9-4%0.1,
b —
< |

Cormrand Window

> b=[l,6,-9,2,5.8,3qrt(6) ,4%3, factorial [5),6%3.4,9-4%0.1,1/74]

b

Column= 1 through 7

1.0000 &.0000 -9.0000 Z.0000 5.8000 2.4495

Columns § through 11

1z0.0000 27.2000 g.6000 0.0135

»> h!

.ooon
.0ooo
pulaia]
.ooao
L3000
L4495
.oooao
l=0.0000
2000
L6000
L0135

&d. 0000

ﬁ-startl




2.ToIXEia AlOVUOUATWY

® MTtropouue va ava@epBoUue ATOUIKA OTA OTOIXEIQ EVOC
dlavuopartog BalovTtag o€ TTapEvOeon Tov OEIKTN TOU
OTOIXEIO META TO OvOua TNV WETABANTAC TOU
dlavuauatog T1.X. b(3).
O1 O€iKTEC CeEKIVOUV ATTO TO 1 KAl TEAEIWVOUV UE TO
UNKOC Tou dlavuopuaTtog. (Trpoocoxn o d€ikTnNG 0 (MNOEV)
dev XpnolyoTroigital, av Kal ouvnBidetal o€ AAANEC
YAWOOEC TTPOYPOAUUATIONOU).
H evtoAn length(b) uttoAoyilel Tov apiBuo Twv
OTOoIXEiWwV aTO dlavuoua b.




=101

File Edit View Web Window Help

& m’:| % B < cs | & | ? |Current Directnry:|c:1nocumemsand Seffingstahauboldimatiab ¥ | J

n | Cormrmand Window: n |

= || @ | & s =] 4
b =
Gize Bytes|Clazs
1=11 88| double array Columhz 1 through 7
i ] Lk et l.0000 &.0000 -9.0000 Z.0000 5.8000 Z.4495 &4, 0000
1x11 G5 | double array
1xl §|double array Columns § through 11
1x19 152 | double array

1=20.0000 27.2000 g.e000 0.0135

== bil)

K13 Warkspace | current Directary |

Command His r |
b=[10:20] *I ans =
at+h
a*h -9
a.*h

=» hizZ0)
b=[10:22] 222 Index exceeds matrix dimensions.
a+h
a »>= lengthib)
b=[1,6,-9,2,5.8,58qrt(6) 43, factorial (5) ,5%3.4,9-4%0.1,

\ ans =
h
h
11

bil)
bi3) *= hil)
bizZ0) 727 Bubscript indices must either be real positive integers or logicals.
lengthib)
b0 ey | —

d| N

mt

1] |
cﬁﬁtart|




OpPICUOC TTIVAKWYV

¢ "Evag mivakag opigeTal e YPOPPEG Kal OTNAEG. Ta OTOIXEID

MIOG ypaupng diaxwpidovral ue KoupaTa N keva, m.x. 1,2,3 .
Ol oTn)\ag 6|axwp|COVTou ME s)\)\nvmo aprnpaTlKo TT.X.
5;6;7 . 'ETO1 Evag TTivakag UTTopEi va opIoTEi yia
napaéalypa

[1,2,3;4,5,6;7,8,9] i

[123;456;789]A

[[1:3];[4:6];[7:9]] .
[Mivakeg PE TIG idIEG OIAOTACEIG UTTOPOUV Va TTPOaTEBOUV Kal
va agaipebouv OTTwg opileTal oTNV ApIBUNTIKA TTIVAKWV.

2TOV TTOAAATTAQCIAOUO OPWG, £XOUHE OIOPOPETIKA
ATTOTEAEOUATA AVAAOYO AV KAVOUUE TOV TTOAAQTTAQCIACHO
XpnaoiygoTrolwvtag v a*b n a.*b , 6rou otV TEAEUTAIA
TTEQITITWAN €ival Tro)\)\an)\aolaopog OTOIXEIO TTPOC OTOIXEIO.




<) MATLAB |

File Edit WYiew Web Window Help

0 E’:| 4 B« s | & | ? |Currer|t Directnry:|c:1nocumems and Seftingsiahauboldimatisb ¥ | J

ﬁ.’- E | H | ﬁ Stadc:IElase VI
Size Evytes|Clas=
3x3 72| double array
3x3 72| double arrav
X3 72| double array

lILI Workspace

Current Directory

Cormrand History

-- 1/09/04 7:EZ PM --%
a=[1l,2,3:4,5,6:7,8,9]
b=[[%:11]:0.7,0.9,1.1:[0,0,0]1]
ath

a-h

Cormrmand Windoes

»» a=[1,2,3:4,5,627,8,9]

a =
1 3
5 &
7 ]

% h=[[9:11]:0.7,0.9,1.1:[0,0,0]]

b =
Q.00oa0 10,0000 11.0000
0.7000 0.9000 1.1000

0 0 0
> ath
10,0000 12.0000 14,0000
4.7000 L.a0oa0 7.1000
7.0000 g.00o00 Q.00o0a0
»» a-h
ans =
-5.0000 -5.0000 -5.0000
3.3000 4.1000 4.9000
7.0000 g.0000 9.0000
]

+\ Start |




Tuyxaiol apiBuoi

® MTtropouue va dnUIOUPYOOUUE TUXAiol aplBuouc,
dlavuouaTa Kal TTiVAKES XPNOIMOTTOIWVTAC TN
ouvapTtnon rand.

H rand d€xeTal wg opiopara Tov apiOuo Twv
YPOUMWV(rows) Kal Tov apiOuo Twv otnAwyv (cols):
rand(rows,cols) kai ETTIOTPEPEI EvVaV TTIVOKA JE QUTEC
TIC DIOOTACEIC YE OTOIXEIQ TUXaioug aplBuouc atro 0
ewg 1.
H ouvapTtnon utropei va TToAAaTTAaCcI0oTE Kal/f) va
TTPOOTEDEI ue apIOUOUC, £TOI WOTE VA TTAPAYEI TUXAIOUG
apIBPOUC O€ OTTOIOdNTIOTE EUPOGC TINWYV, TT.X.

yia Tuxaio apiOuo peracu 0 kai 10: rand(1,1) * 10,

yia Tuxaio apiBuo peracu 10 kar 100: (rand(1,1) * 90) + 10 .
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File Edit View Web Window Help

& m’:| % B < s | & | ? |Current Directnry:|c:1nocumemsand Seffingstahauboldimatiab ¥ | J

n | Cormrmand Window:

ﬁ.’- H | H | ﬁ Stad(:IElase VI

Gize Bytes|Clazs

3x3 72| double array

1x3 24| double arrav

X3 72| double array

3x3 72| double array >*> rand

0.9501

== rand(l,3)

ans =

I 1| VWorkspace | Current Directory
0.2311 0.6068 0. 4860
Comrand His
$-- 1/09/04 7:52 FPM —-% == d=rand(3)
a=[1,2,3:4,5,6:7,8,9]
b=[[9:117:0.7,0.9,1.1:[0,0,071] d =
a+h
0.8913 0.0185 0.6154

a-b 0.7621 0.5214 0.7919
a*h 0.4565 0. 4447 0.9218
a.*h
a > d=rand(3)*10
al 1

d =
rand
rand(l,3) 7.3821 9.3547 5.9365
d=rand|(3) 1.7627 9, 1690 0.5789
d=rand{3)*10 4,0571 4,1027 3.5287

= —

1 e

cﬁﬁtart|




[lpocApTNON TTIVOKWV

® [livakeg Kal diavuopaTa JTTopouyv va TTpocapTniouy
yia va ONUIOUPYNOOUV JEYAAUTEPOUC TTIVOKEC Kal
dlavuouara.

‘EoTw dlavuouarta a kai b, éva véo diIdvuoua € PTTOPEI
va dnuioupynBei ue c=[a,b] . ¢ £xel unkog 6o 10 a Kai
10 b padi.
To id10 10XUEI KAl YIO TOUG TTIVOKEG, Ba TTPETTEI ONWC
avaAoya pe Tov TPOTTO TTOU YiVETAI N TTPOCAPTNON VA
OUM@PWVOUV OTN OlA0TAON YPAUUWY ) OTNAWV.
[1.x. Evag 3x3 Trivakag a JTropei va ouvOuaaoTEi JME Evav
3x5 Trivaka b w¢ [a,b] ox1 opwc wg [a;b] , evw €vag 3x3
TTivaKkag a JTTopei va ouvouaoTei Je evav 5x3 TTivaka b
w¢ [a;b] aAAa Ox1 we [a,b] .




File Edit View Web Window Help

& m’:| % B o s | & | ? |Current Dirednry:|c;mucumems and Settings\ahauboldmatish

=

=101 %]

Ll =1 | Cormrand Window
ﬁ.’- H | H ‘ ﬁ Stadc:IElase TI

Size Bytes|Clazss

3x3 72| double array

1x3 24| double array >> c=[a,b]
X3 72| double array

4] 2868 | double array c =

3x3 72| double array

1.0000 2.0000
4.0000 5.0000
7.0000 g.0000

»» c=[azh]

IK1 13| Workspace | current Directary |

Cormrmand History

4, 0000 5.0000

a=[1l,2,3:4,5,6;7,8,9] *I 7.0000 g.0000

| 1.0000 &.0000

b=[[9:11]:0.7,0.9,1.1:[0,0,0]] 9.0000  10.0000
ath 0.7000 0. 2000
o 0 0
a*b »» c=[a,b:b,a]
a. *h
a' o o=
Iy
rand 1.0000 Z.0000
rand(1,3) 4,0000 5. 0000

7.0000 &.0000
d=rand(3) 9.0000  10.0000
d=rand (3] *10 0.7000 0. 9000
c=[a,h] 0 ]
c=[a:h]
c=[a,b:b,a] e

==

F.0000
.ooao
9.0000

3.0000

. 0aaon

9.0000

11.
. 1000

aooo

. 0oaon

&.0000

.ooao
11.
L1000

aooo

S.0000
0.7000
0

9.0000
0.7o00

l.0000
4, 0000
T7.0000

1a.
0.

10.
2000

aooo
000
0

naoa

.0oaon
. 0oaon
.0aaan

11.
1.

11.
.100a

oooo
1000
0

oaoa

.oooo

a.0000

.0ooon

4h5tart|




[1lpooTTEAQCN OTOIXEIWV TTIVOKO

® H 1TpooTréAadOn OTa OTOIXEIO EVOG
TTiVOKQA YIVETAI JE TOUG OEIKTEC
YPauuNg Kai oTAANG: A(r,c), 0Tou A A7 5128

91(-1134/ 3 19

N|W| 00|~

gival O TTiVvaKag, r n ypauun, Kai ¢ n 5006781
')\ -118 191/ 7|4

GTﬂ n A(2,5) =19

¢ ET”W]Q |J'|TOpOU|J€ va €X0UU5 A= |5]/1]-9/8]917
TTPOCTTEAQCN O€ YPAUMEG KAl OTMAEG. 9|-124319[ 8
Mo TV TTPOOTTEACN OF Yia ypappr S SIEIEAE
TOU TTivaka A 10 cUuBoAO (:) A(3,)=5,0,061,819]
QVvTIKABIOTA TNV OTHAN, KAl A= [5[1 <617
avTIOTPO®A YIa TNV TTPOCTTEAQCN 9133198
oTnVv oTNAN: 8[o1]7]4]2

4

1
row_r = A(r,:) ALY

column_c = A(:,c) .
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File Edit View Web Window Help

& m’:| % B o s | & | ? |Current Dirednry:|c;mucumems and Settings\ahauboldmatish

=101 %]

=

ﬁ.’- H | H ‘ ﬁ Stadc:IElase TI

n | Cormrand Window

Size Bytes|Clazss
3x3 72| double array
1x1 G| double array
X3 72| double array
4] 2868 | double array
3x3 72| double array
= oa
a =
1 2
&
7 g

IK1 13| Workspace | current Directary |

rand{l,3)
d=randi(3)
d=rand(3)*10
c=[a,h]

c=[a:h]
c=[a,b:;hb,a]

ceil (7.26746395)
floor (7.26746395)
ceilid)
ceiljrand(3,3)%10)
a

afl,l)

af3i,l)

afl,3)

1
= oald,l)
ans =

7
= all,3)
ans =

3
>>|

=| Ll

ﬁ-startl




File Edit WYiew Web Window Help

<) MATLAB

0 E’:| 4 B« s | & | ? |Currer|t Directnry:|c:1nocumems and Settings\ahauboldimatish

=1

=10l %]

i kspace 2] x]|
= = W - G Tt |

Size Evytes|Clas=

3x3 72| double array

3x3 72| double arrav

X3 72| double array

[ 288 | double arrawv

3x3 72| double array

JE1 I3 Warkspace | current Directary |

Command History
c=[a,h]
c=[a:h]

c=[a,b:;b,a]

ceil (7. 26746395)
floor(7.26746398)
ceilid)

ceil (rand(3,3)*10)
a

afl,l)

al3, 1)

alrl, 3)

alz,:1

af:,;z2)

af:, )

L]

Cormrmand Windoes

Pxoald )
ans =
4 5 &
Pxoal: 2)
ans =
2
5
g
= oali, )
ansg =
1 2 3
5 &
7 g E
>>|
1

+\ Start |




YTTO-TTIVOKEC

® Y1rapyxel duvatotTnta

VA ECAYOUME TUNMOTA A= [5]1]9]8]91]7
’ ’ 91-113413 19| &
EVOC TTivaka (UTro- 510061819
’ 7 -118191 742
T”VGKEQ),IJ&: XQHGH A(2:3,3:5)=34 3 19
Ola0TNUATWY OTTWC 0 6181

[1,2] n [1:3] wg
OEIKTEC.
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File Edit Yiew Web ‘Window Help

O = | i B < o | & | ? |Currerrt DirEC't':'r‘:-"illC:'ch:cuments and Settings'ahauboldinatiab j J

= = HB Cormmand Windows
ﬁ- E | m | ﬁ Stadc:IElase VI
Size Evtes|Claszs
3x3 72| double array
23 48 | double array
Ix3 72| double array = oali, )
EXE 288 | double array
3x3 72| double array SHSES
1 2 3
5 &
7 g 9
r oal[l:2],[1:2])
4| r[ | :
Warkspace Current Directony ans =
Cormrand History | 1 3
c=[a,b:;b,a] *I
ceil (7.26746398)
£loor (7. 26746398) »> alll,3].[2,3])
ceilid)
ansg =
ceil(rand(3,3)*%10)
a 2 3
ail,l)
a(3, 1]
arl,3) == al[l,3],:]
alz,:1 T
al: 2]
af:,t] 1 2 3
al[l:2],[1:2]) 7 g 9
ai[l,31,[2,3]]
e =
al[l,.3],:]) =
| [« [

<\ Start |




Y TTO-TTIVAKEG

® ETtTionc ytropoupue va

A= |5|1]-9
QVTIKATAOTIOOUUE 9]-1/34
4 , , 5010
TMAMATA EVOC TTiVaKa
XPNOIUOTTOIWVTAG AG)=B(224)
TOV i010 TPOTTO i ’
4 ’ = |8 |91 7f|-1
AVA@POPAC OEIKTWV. s ol o




File Edit WYiew Web Window Help

<) MATLAB |

=10l %]

0 E’:| 4 B < cs | & | ? |Currer|t Directnry:|c:1nocumems and Settings\ahauboldimatish

=1

i kspace 2] x]|
= = W - G Tt |

Size Evytes|Clas=

3x3 72| double array

1x3 24| double arrav

X3 72| double array

[ 288 | double arrawv

3x3 72| double array

Current Directory |

al3,l)

ail,3)

ai2,:)

al: 2]

af:, =]
al[l:2]1,[1:2])
aifl,31,[2,3]]
al[l,3],:)

a

b

ald,:l

bi3;:)
bhi3,:)=a(3,:)

L]

Cormrmand Windoes

a =
1 2 3
5 &
7 3 9
= b
b =
9.0000 10. 0000 11.0000
0.7o00 0.9000 1.1000
0 0 0
Froald )
7 3 9
= b3,
ans =
a 0 0
= b3, )=a(3,:)
b =
9.0000 10.0000 11.0000
0.7o00 0.9000 1.1000
7.0000 g.0000 9.0000
=
1] | »

+\ Start |




® ['1a ypriyopn BonBecia yia otToiadATTOTE
ouvaprtnon tn¢ Matlab.

® >> help <function>

® [1.x >> help rand, 0ivel fonbeia yia
TNV ouvaptnon rand.




=10l x|

File Edit WYiew Web Window Help

0 E’:| 4 B« s | & | ? |Currer|t Directnry:|c:1nocumems and Seftingsiahauboldimatisb ¥ | J

n B | Cormrmand Windoes

ﬁ.’- E | H | ﬁ Stadc:IElase VI

Size Evytes|Clas=
3x3 72| double array ¥» help rand
1x3 24| double arra
¥ EAND Tniformly distributed random numbers.
3x3 72|double array FAND (M) is an N-by-N matrix with random entries, choszen frow
BXEG 288 | double array a uniform distribution on the interwal (0.0,1.0).
Sy3 72| double array FAND (M, N) and RAND([M,N]) are M-by-N matrices with random entries.
FAND(M,N,P,...) or BaND([M,N,P,...]) generate random arrays.
FAND with no arguments is a scalar whose walue changes each time it
iz referenced. ERAND(3IZE(A)) iz the same size asz 4.
FAND produces pseudo-random numbers. The sequence of numhers
generated is determined by the state of the generator. 5Since MATLALE
resets the state at start-up, the sequence of numbers generated will
[l iorkspace | Current Directory | be the same unless the state is changed.

Cormrnand His 3 |

3 = BAND('state') is a 35-element wvector containing the current state

afl,l) AI of the uniform generator. RAND('state',3) resets the state to 3.
a3, l) FAND [ 'state',0) resets the generator to its initial state.
ail,3) FAND ([ '=tate',J), for integer J, resets the generator to its J-th stat
r
al2,:] FAND [ 'state',sum(l00*clock)) resets it to a different state each time
e
al:,2) This generator can generate all the floating point numbers in the
al:,:) closed interwal [2+(-53), 1-2Z+(-53)]. Theoretically, it can generate
al[l:2],[1:2]1) over 241492 walues before repeating itself.
al[l,3],[2,3])
al[l,31,:) MATLAE WVersion 4.x used random number generators with a single seed.
, e
FAND [ 'seed' 0] and BAND('seed',J) cause the MATLAE 4 generator to be
a
FAND [ 'seed') returns the current seed of the MATLAE 4 uniform generat
b FAND [ 'state',J) and RAND('state',3) cause the MATLAE 5 generator to E
a3, :)
bi3, s See also RANDN, SPRAND, SPRANDN, FANDPERM.
bi3,:)=al(3,:) |
help rand £ =
=l 4] | ,

+\ Start |




® [a Tnv atrofnKkeuon cUAAOYWYV EKPPATEWV,
VIO TTAPAdEIYMA VIA TIC AOKNOEIC KAl TIG
EPYOOiEC 0aC, Ba TTPETTEI VO XPNOIUOTIOINCETE
m-files.

® Ta m-files dev gival TiTTOTE AANO TTAPA ApXEia
KEIMEVOU TTOU UTTOPOUV VA EKTEAECTOUV UECW
Matlab yia va avatmrapdayouv TIC EVTOAEC TTOU
TTEPIEXOUV.

® [Na Tnv dnuioupyia evog veou m-file:
File -> New -> M-file




<) MATLAB : =10 x|
Filz Edit ‘iew ‘Web ‘Window Help
ITlis l‘ﬂ Directory: | CDocuments and Settingstahauboldimatiab j J
Cpen... Chr+0 Figure
Close Command Window Chrl4+y Model | Command Window
GUI

Irnport Data,.. -
Save Workspace As. ..

Bytesl Clas= |

Set Path...
Preferences. ..

Page Setup...
Prink. ..
Frint Selection...

1 b, \matlabiimagetest.m

Exit: MATLAE Chrl+0

JE1 I3 \orkspace | Current Directory

Cormrand History

(-- 1709704 5:00 PM --%

+\ Start |




® [a TNV dnuIoupyia evog véou m-file:
File -> New -> M-file

® ElodyeTe KATTOIEG EVTOAEG, pia ava ypauun.
(©a ooupE o€ ETTOPEVO PHABNUA TTWG

ONMIOUPYOUUE CUVAPTHOEIC XPNOIUOTTOIWVTAG
m-files).

® AmmobnkeuoTte TO0 m-file oT0 matlab directory
TTOU VWwpPITEPA eixarte opioel w¢ Current
Directory.

® To apyeio Ba TTPETTEI va €XEI OTTWOONTTOTE TNV
KATAAN¢n .m
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File Edit “iew Text Debug Breakpoints ‘Web ‘Window Help

NEH| 2R | S MF | 88 |B0RE DA s ] x
b B
c=a+h
d=1a
e=d-h*c

L e e

\script 'Ln & Cal &




=TS

File Edit View Text Debug Breakpoinks ‘Web  Window  Help

D H| {BE2BRoo | 3| dFf| 88| BRE B | sl > x

1 a=3 |l —
2 b=5
4 d=2a _
g e=d-h*c Save in:l'ﬁ matlab j - £F B~
1
2
3
4
a3
]
File harme; b uFirstE wercize. m S ave
Save az ype: | Al Files [*7) j Cancel

a >

\script 'Ln 5 Cal 8




ExTéEAeon m-file

® MTTOPEITE TWPA VA EKTEAETETE TIC EVTOAEC
ToU m-file TTANKTPOAOYWVTAC TO Ovoud
Tou m-file (xwpic¢ Tnv KATGANEN .M) OTO
Command Window.
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File Edit WYiew Web Window Help

0 E’:| 4 B < cs | & | ? |Currer|t Directnry:|c:1nocumems and Seftingsiahauboldimatisb ¥ | J

Current Directory nm Command Window
IC:‘-.D::ucuments and Settings‘-.ahauhnld‘-.mfll J| £ ‘ g4 | |»> M¥FirstExercise =
411 File= |File Type |Last Modified | a =
g1 Folder 09-Jan-2004 03:01 PM
3
gz Folder 08-Jan-2004 11:51 AM
s Folder 05-Jan-2004 11:51 4M
g4 Folder 21-Dec-2003 06:09 AM b =
s Folder 21-Dec-2003 06:21 AM .
e Folder 21-Dec-Z003 0&:258 AM
HyFirstExercise.m M-file 09-Jan-2004 05:02 PM
C =
ﬂ ?

Current Directory

d =
Cormrand History |
(-- 1409504 S:00 PM --% 9
MyFirstExercisze
B =
-31
Fr

+\ Start |



® H £codoc atro 1n Matlab yiveral ye Tnv
EVTOAN exit N quit
m.X >> exit




[TANpOPOpPIEC

® Wwww.cs.uoi.gr/~develeg/matlab
Intro.pdf - Introduction to matlab
Matlabprimer.ps — MATLAB primer
MatlabL1.pdf — 10 M&Bnua
Askisis1.pdf — Aoknoeic 1ou pabruartog
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